
Product Bulletin #233  
 

Retrofit of Three Line Display to Next Generation 
Configuration 

NOTE • There are significant differences between this Next Generation 3LD and the previous 
model covered in Product Bulletin 221: 

o Pricing is picked up from the FMU; no longer has to be loaded into the display with 
a laptop 

o Any one of up to 8 products and unit prices configured in FMU may be displayed 

o LED light intensity is programmable with a laptop connection to FMU; there may 
be one higher setting for daylight, and a less intense setting for nighttime. Display 
is visible in direct sunlight. 

o Programming of display is only necessary if firmware must be updated. 

• PULSE FILTERING does not affect the Next Generation 3LD. It may be turned on or off. 

• When an electronic dispenser is used with the 3LD, there can be up to a 10 second delay 
between disconnecting the hose and final updates to the display. The delay is variable but 
does resolve to the correct quantity and total cost. This delay does not occur with 
mechanical pumps. 

Description 
This document is prepared to facilitate the retrofit of the original configuration Three Line 
Display (3LD) to the Next Generation configuration. The Next Generation 3LD displays 
information drawn from FMU memory. Aside from initial configuration to prepare the retrofitted 
3LD for use, no adjustments are necessary at the display. 

 

Figure 1 

It is assumed the display was installed and operational prior to the retrofit. See Figure 1 for an 
illustration of parts contained in the standard retrofit kit. Other parts may be supplied in unusual 



6/30/2023 Retrofit of Three Line Display to Next Generation Configuration 
 

If any questions arise, please contact Syntech Systems, Inc.’s Customer Satisfaction Center at  
1-800-888-9136, ext. 2 or email support@myfuelmaster.com. 2 
 

circumstances. An RMA and Federal Express return shipping ticket has been supplied with the 
retrofit kit parts. We request the Pulser Card (from the Internal Junction Box) and External 
Junction Box be returned to Syntech. 

Reset Display Configuration Before Retrofit 
Some display settings must be turned off, or minimized before any disassembly. It will be 
necessary to make a laptop connection to the External Junction Box located in the FMU. The 
display settings covered in this section apply to all three display lines. When updating the 
firmware on all three display lines, check that Fuel Price, Mode, Messaging, and ALS settings are 
the same on all three display lines.  

Load the Display Software 
This tutorial assumes: 

• You have the FuelMaster Manager Software loaded on a laptop.  

• You have copies of the firmware to be loaded into the display which also loaded on the 
flash drive. 

1. Unzip the FuelMaster Manager Software- 2.0.1.10.zip file 

2. Click setup.exe. The software program will load and create an icon on the desktop. When 
it opens it will scan for a display, and prompt No Display found (Figure 2). 

 

Figure 2 

Connect Laptop to the Display  
This tutorial assumes the display Programming Cable with a DB9 serial connector is attached to 
the External Junction Box in the FMU upper cabinet.  

1. Connect the Programming Cable to the laptop (a USB/serial adapter may be necessary). 
The comm port used to connect to the display may be set to the same settings required 
of the FMU: baud rate 19,200; 8 data bits; no parity, 1 stop bit, XON, XOFF.  

2. Apply power to the display. Existing installations have a 12VDC power supply powering 
the display.  
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3. Open the FuelMaster Manager Software program. 

4. Click File > Auto Connect (Figure 3). The program will scan for a display and prompt 
Loading successfully completed when a connection is established. If Auto Connect does 
not provide a connection, click Connect and provide a serial port number, then click 
Connect. 

 

Figure 3 

When a connection is established between the software and the display, the Status box will 
change from Link: Disconnected to Link: Connected to COM_. 

NOTE After making any changes with the software, the box at the bottom of the software screen, Save 
Settings into Display, must be clicked on to save the changes before exiting the program. 

Set the Fuel Price to 0.000 
1. Click Tools > Fuel Price > Set Fuel Price (Figure 4). An Updating Fuel Price in Terminal 

window will open. 

 

Figure 4 

 

Figure 5 

2. Type password, or use the designated password (Figure 5).  

NOTE If using the customer’s laptop and no password works, the software must be uninstalled and then 
reinstalled. 

3. Type 0.0000 in the Fuel Price field.  

4. Select Update.  

5. In the Mode dropdown, select Fuel Terminal Free Text.  

Update the Display Firmware 
Display line firmware versions should be as follows: 

Top line: EVT1.51; Middle line: EVT1.11; Bottom line: EVT1.11 

1. Verify the Fuel Price, Mode, Messaging, and ALS settings are the same on all three 
display lines. 
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2. Select on the Update on the left side of the screen under General Settings. A Display 
Firmware Update Tool window will open (Figure 6).  

 

Figure 6 

3. Select Browse… to locate and highlight the firmware file name. The 
filename will populate the box at the top of the window. As the firmware 
is being updated, a progress bar will be shown in the box at the bottom of 
the window.  

4. Select Close when the update is complete, and disconnect via File > 
Disconnect. 

5. To update the middle and bottom lines of the display, move the programming cable from 
the DB9 connector on the External Junction Box, to the DB9 connectors in the Internal 
Junction Box inside the 3LD.  

6. Remove the faceplate of the display to access the Internal Junction Box.  

7. Remove the four Philips head screws from the four corners of the faceplate.  

CAUTION The faceplate is heavier than it looks. Be sure to support it as the screws are removed. 

8. Remove the four screws for the Internal Junction Box cover. There is a Pulser Board 
attached with Velcro to the underside of the cover.  

CAUTION Be careful removing the cover not to pull any wires loose. 

9. With power still applied to the display, move the programming cable to the upper DB9 
connector in the Internal Junction Box.  

10. Click File > Auto Connect. A prompt Link: connected to COM_ will show in the Status 
box. The Address tab in the bottom half of the software screen will switch from Device 
Id: 0 to Device ID: 1 to indicate you are connected to the middle line of the display.  

 

Figure 7 

11. Select Update as you did for the top line.  

12. Select Browse to highlight EVT1.11. The firmware box will populate with EVT1.11, and the 
middle line will be updated. 
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13. Disconnect the software from the display, and move the programming cable to the 
bottom DB9 connector in the Internal Junction Box.  

14. Auto Connect to the display. The Address tab should reflect Device Id: 2 when 
connected to the bottom line of the display.  

15. Repeat the procedure used with the middle line of the display to update the bottom line 
of the display to EVT1.11. 

16. When complete, do not close the Internal Junction Box or reinstall the faceplate. They will 
need to be accessed after the display is reconfigured using the software. 

Disable Messaging 

See Figure 8. The messaging options must be disabled.  

 

Figure 8 

1. Reconnect to the display through the External Junction Box. 

2. Select the Message tab.  

3. Unclick Enable next to Before Delivery and After Delivery. The box next to Display total 
and stop scrolling…. should uncheck automatically. 

Disable ALS (Ambient Light Settings) 
See Figure 9. The ALS settings must be disabled.  

 

Figure 9 

1. Select the ALS tab.  

2. Uncheck the box next to Enable. 
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Save Settings into Display 
Very Important! The setting changes will not be saved unless the Save Settings into Display 
button is depressed prior to disconnecting from the display. Click on the Save Settings into 
Display button. 

Disconnect from Display 
1. Select File > Disconnect.  

2. Disconnect the laptop in accordance with Product Bulletin 111. The display is configured 
for the retrofit. 

NOTE The Flash Loader must be installed with FMU power off, oriented A to A, and B to B, and the 
jumper in the top two pins. More details in Product Bulletin 198. 

Important! When performing an FMU firmware upgrade, it is important to follow the 
guidance of Product Bulletin 218, Screenshots for FMU Firmware Updates/Recovery. 
Screenshots of the FMU configuration are taken before the upgrade, then the FMU is 
initialized to clear memory of the old firmware. The screenshots can then be used to 
reconfigure the FMU to the customer’s preferences with the new firmware. 

Upgrade FMU Firmware and FuelMaster Software.  
Version 3.91 or later FMU firmware, and version 5.8.3.0 or later FuelMaster software must be 
installed for the 3LD retrofit. The FMU firmware will be provided on a Flash Loader (Syntech 
part number 234362C). See Figure 10.  

 

Figure 10 

1. Turn off the FMU. 

2. Insert the Flash Loader into the DEBUG MEMORY socket of the FMU mainboard (being 
sure to align A to A, and B to B). 

3. Turn the power back on. After some time, you will be prompted that the firmware 
transfer is complete. 

4. Turn off the FMU power. 

5. Remove the Flash Loader.The firmware update is complete. 

Version 5.8.3.0 FuelMaster software is provided in two versions: server.exe has Sequel server 
software included. Client.exe is for customers who already have Sequel server software and 
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don’t need to add it. It is best to follow the instructions for installation provided with the 
software. 

Remove Pulser Card from Display.  

1. Remove the power from the FMU and Display at the circuit breaker.  

2. Remove the Pulser Card from the display Internal Junction Box. 

3. Reconnect the Internal Junction Box to bypass the Pulser Card., and the cable to the 

4. The Internal Junction Box can be found behind the display faceplate, which should have 
been removed when the display firmware was upgraded, in the upper left corner. See 
Figure 11 for breakdown. 

5. Remove wires from the Pulser Card by inserting a small common screwdriver into the 
rectangular slot next to the wire receptacle, and pressing down against spring tension. The 
wire will release when enough tension is applied. Discard. 

6. Remove wires from the P2 and P5 connectors in the Internal Junction Box by pressing down 
on the orange release with a small common screwdriver. Discard. 

 

Figure 11 

7. From the Pulser Card. Shorten the grey and pink wires to the same length as the other wires 
in the cable, and reconnect to the Internal Junction Box. The red and blue conductors in the 
cable from the External Junction Box are not used in the retrofit, and may be cut back and 
taped. 

8. Remove the Pulser Card from the underside of the Internal Junction Box cover. It is 
attached with Velcro. Don’t try to remove the Velcro. A Wiring Label with an adhesive 
backing is supplied with the retrofit kit. Remove the backing from the adhesive, and attach 
the Wiring Label to the top side of the cover. The Wiring Label was designed for new 
installs, and two wire colors are different: grey is correct for PUL2 (instead of red), pink is 
correct for PUL1 (instead of black). 
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9. Figure 12 

See Figure 12. There should be six cable conductors remaining connected inside the Internal 
Junction Box: green to Vin, white to GND, brown to DgRX, yellow to DgTX, grey to PUL2, 
and pink to PUL1. 

The ON/OFF switch must remain ON. Changes are complete inside the display. Recommend 
the Internal Junction Box or display not be closed up until a test has been performed after 
the retrofit is complete. 

 

Remove External Junction Box.  
The External Junction Box is affixed to the FMU upper cabinet sidewall with Velcro. Remove as 
follows (see Figure 13). 

 

Figure 13 

1. Verify FMU power is removed. 

2. Unlock and open the FMU upper cabinet door. 

3. Separate the External Junction Box from the Velcro fastener. 

4. Loosen the four junction box cover screws and remove the cover. 

5. Disconnect the display cable from the P3 and P4 connectors. 
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6. Loosen the cable gland and remove the display cable from the External Junction Box. The 
display cable will connect to an I/O Silver Board in the FMU pedestal. The cable may be re-
routed to the FMU pedestal at this time. 

7. Unplug the Power Supply from the FMU outlet, but keep it in the FMU. The power supply 
will be needed with the retrofit. 

8. Disconnect the pulser wire from the FMU Pedestal I/O Board pulser connector (J4, J5, J6, or 
J7). 

9. Disconnect the +12V RESET wire from the Dual Control Relay Assembly, or the SPST RELAY, 
if applicable. If a relay was added for the reset, the relay may be removed. 

10. Disconnect the 0V COMMON wire from the applicable J4, J5, J6, or J7 0V connector. 

11. The External Junction Box and Power Supply will not be used with the retrofit. Use the Fed 
Ex return ticket to return them to Syntech with the Pulser Card. 

NOTE PULSE FILTERING on the FMU Satellite I/O Control Board was previously required to be 
turned off with the 3LD. It is not required with the Next Generation configuration. It may be 
turned on or off. 

Install FMU Components  
The Quad UART (QUART) Board, I/O Silver Board, and Quad UART to I/O Silver Board 
connecting cable must be installed in the FMU. Perform the following: 

1. Verify FMU power is removed. 

2. Unlock and open the FMU upper cabinet and pedestal doors. 

3. Install the Quad UART Board: 

a. Verify jumpers (3 each) are installed in the upper RS232 positions of J1, J2, and J5 
on the Quad UART Board next to SER PORT A. 

b. Verify jumpers (2 each) are installed in the QUART2 positions of the Quad UART 
Board. 

c. Verify the MASTER MODEM JUMPER is removed from the Quad UART Board. 

d. On the main board over the expansion slots, loosen the two holddown bracket 
screws and raise the holddown bracket. 

e. Insert the Quad UART Board in an unused expansion slot on the main board. 

f. Lower the holddown bracket over the Quad UART Board and any other expansion 
boards, and tighten the bracket screws. 

4. Loosen the four screws for each panel, and remove the upper and lower electrical access 
panels in the FMU pedestal. 

5. Install the I/O Silver Board. The 3LD may be installed and used in conjunction with other 
components utilizing an I/O Silver Board such as the Electronic Dispenser Interface and Tank 
Monitor Interface. 

a. If no other I/O Silver Board is installed: 
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i. Remove the six 6-32 screws located near the top and bottom of TB1, TB2, 
and TB3 on the Pedestal I/O Board. 

ii. Install the six 199273 one inch standoffs in the screw holes near the top and 
bottom of TB1, TB2, and TB3. 

iii. Align the I/O Silver Board provided with the retrofit kit over the standoffs 
and reinstall the six 6-32 screws to secure the I/O Silver Board to the 
standoffs. There are several holes through the I/O Silver Board, but only six 
that align with the six standoffs. 

iv. Plug the three 5 pin terminal blocks into JP5, JP6, and JP11 of the I/O Silver 
Board. 

NOTE Standoffs are measured in the hex area, only. See Figure 14 

 

Figure 14 

b. If an I/O Silver Board for another application (Electronic Dispenser Interface, Tank 
Monitor Interface, Satellite FMUs) is installed, the 3LD I/O Silver Board must be 
installed over the existing I/O Silver Board: 

i. Remove the six 6-32 screws securing the existing I/O Silver Board to 
standoffs, and move the I/O Silver Board aside. 

ii. Unthread and remove the six one inch standoffs installed near the top and 
bottom of TB1, TB2, and TB3. 

iii. In their place, install the six ¾ inch standoffs (Syntech part number 236527). 

iv. Position the existing I/O Silver Board over the ¾ inch standoffs and thread 
the 1-1/8 inch standoffs (Syntech part number 194271) through the holes in 
the I/O Silver Board into the ¾ inch standoffs. Be sure all connections into 
this I/O Silver Board are complete. There will not be room to make 
connections after the second I/O Silver Board is installed. 

v. Position the new I/O Silver Board over the screw holes in the 1-1/8 inch 
standoffs, and reinsert the six 6-32 screws through the I/O Silver Board into 
the 1-1/8 inch standoffs. 

CAUTION The 952B0103 Quad UART to I/O Silver Cable can be installed incorrectly, and result in 
damage to FMU components. The cable is labeled TO FMU QUAD UART BOARD on one end, 
and TO I/O SILVER BOARD on the other end. Be sure to make the connections accordingly. 

6. Connect the 952B0103 cable connector labeled TO FMU QUAD UART BOARD to J14, 
SERIAL PORT A of the Quad UART Board. 

7. Connect the 952B0103 cable connector labeled TO I/O SILVER BOARD to JP12 of the I/O 
Silver Board. 
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8. The FMU components are installed. Do not reapply power. Go to Wire the Display to 
complete the wiring. 

Wire the Display 
The display may now be connected to the new FMU components. Figure 15 illustrates the 
connections in the FMU. Additional wiring guidance is provided in the Troubleshooting section 
for troubleshooting purposes. 

NOTE If the receptacle of the 178802A power cable is being used for other purposes, another 
receptacle must be provided. Another receptacle may be wired into the incoming AC power 
wires for the FMU, after the surge panel. 

The loose leads from the display cable may not be long enough to reach all connection points in 
the FMU pedestal. It may be necessary to cut back more cable insulation before proceeding. 

Perform the following: 

1. Plug the existing 12VDC Power Supply into the receptacle of the 178802A power cable in 
the FMU upper cabinet, and route the two DC power wires through the thru-hole 
between the upper cabinet and pedestal. 

2. Route the display cable into the pedestal. The red and blue wires will not be connected to 
anything, and may be bent back and taped. 

3. Perform the following to make connections to the 264736 I/O Silver Board provided with 
the retrofit kit (see Figure 15): 

a. The power supply hot wire has a label on it, POSITIVE (+). Twist it together with 
the display cable green wire and connect both into JP5, IN+. 

b. Connect the power supply ground wire into JP5, GND. 

c. Connect the display cable yellow wire to JP6, IN+. 

d. Connect the display cable brown wire to JP6, OUT-. 

e. Connect the display cable pink wire to JP11, OUT-. 

f. Connect the display cable white wire to JP11, GND. 

g. Connect the display cable grey wire to JP11, IN+. The red and blue wires are not 
used. 

h. Connect the breakout board with jumper wires as follows: 

i. Run a jumper wire from JP6, IN+, to pin 2 on the breakout board. 

ii. Run a jumper wire from JP6, OUT-, to pin 3 on the breakout board. 

iii. Run a jumper wire from JP5, GND, to GND on the breakout board. 

iv. Using the Velco tape, affix the breakout board to the I/O Silver Board. Do 
not cover any screw holes in the I/O Silver Board. When a connection to the 
breakout board is necessary, the Velcro connection is separated to suspend 
the board from the jumper wires and permit access with a laptop 
connection cable. Wiring is complete. 
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Figure 15 

Power the Display 
1. Reapply FMU power. When the FMU power switch is turned on, the display will initialize: 

2. Each of the three displays will self-test by flashing decimal points along with six sets of 
numbers 9 down to 0 (example: 99999.9, 8888.88, 777.777, etc.) 

3. Then the firmware loaded in each display (example: EVT1.51). The top display has different 

4. firmware than the middle and bottom displays, 

5. Then the configuration: FT L1 on top, FT L2 in middle, FT L3 on bottom. 

6. Before the display is enabled, the bottom line will only display 0.000. After the display is 
enabled (in Configuring the Display), 0.000 will also display on the top line, and 0.00 will 
display on the middle line after the FMU completes initialization. Displays on the top and 
middle lines will always be delayed. 

7. If the display initialized correctly, close the display (reinstall the display internal junction 
box cover, and reinstall the display faceplate). 

8. Reinstall the electrical access panels in the FMU pedestal, and close and lock the FMU 
pedestal door. 

9. Go to Configure the Display. 
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Configure the Display 
Configuring is necessary to enable the display through the FMU, and set the light intensity of 
the LEDs. Make a laptop connection to the FMU in accordance with Product Bulletin 111. When a 
connection to the FMU is established, enter command E1. The following Three Line Display 
Menu will appear with default values shown: 

Three Line Display Menu: 

1. Display Enabled (Requires Reboot, Disables Bluetooth): DISABLED 

2. Daytime Intensity (%) : 100 

3. Nighttime Intensity (%) : 50 

4. Daytime Start Time : 07:00:00 

5. Nighttime Start Time : 20:00:00 

6. RESTORE DEFAULT VALUES  

Select Operation (ESC Exits) : 

 

1. At the cursor next to Select Operation (ESC Exits):, enter 1 to enable the display. 
DISABLED will change to ENABLED. The display will not be enabled until the FMU is 
rebooted (power off, then on). Initially, when enabled, the bottom line of the display will 
display 0.000. After a few seconds, the top line will display 0.000, and the middle line 
will display 0.00. If not enabled, the top and middle display lines will not display. 

NOTE LED light intensity can be adjusted for daytime or nighttime operation. Daytime typically 
requires brighter lighting to defeat the brightness of sunlight. Much less intensity will be 
required for nighttime use. It might be wise to use the default values until you have the 
opportunity to observe the intensity. 

LED light intensity setting changes (for intensity % and start times) will change after 5 minutes, 
or when a new transaction is started. The FMU checks change settings every 5 minutes. 

2. To change Daytime Intensity (%):, at the cursor next to Select Operation (ESC Exits): 
enter 2. The prompt Enter a Number (1-101):   will appear. Enter the desired intensity 
percentage at the cursor, and press Enter. The intensity change will show in the menu. Go 
to step 6 if no other changes are necessary. 

3. To change Nighttime Intensity (%):, at the cursor next to Select Operation (ESC Exits): 
enter 3. The prompt Enter a Number (1-101):   will appear. Enter the desired intensity 
percentage at the cursor, and press Enter. The intensity change will show in the menu. Go 
to step 6 if no other changes are necessary. 

4. Daytime Start Time is the time when the LED intensity changes from nighttime to 
daytime intensity. To change Daytime Start Time, at the cursor next to Select Operation 
(ESC Exits): enter 4 for the operation. A prompt ENTER TIME: : : will 
appear. Enter hours:minutes:seconds for a 24 hour clock, and press Enter. The time 
change will show in the menu. Go to step 6 if no other changes are necessary. 

5. Nighttime Start Time is the time when the LED intensity changes from daytime to 
nighttime intensity. To change Nighttime Start Time, at the cursor next to Select 
Operation (ESC Exits): enter 5 for the operation. A prompt ENTER TIME: : :
 will appear. Enter hours:minutes:seconds for a 24 hour clock, and press Enter. The 
time change will show in the menu. Go to step 6 if no other changes are necessary. 
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6. When all desired setting changes have been made, the prompt Configuration has 
changed. Do you want to save? (Y,N) will appear. Press Y to save changes. Pressing N 
will remove changes. 

Price/Sale/Receipt Options 
This is optional, and not necessary for display operation. These options will provide 1) pricing on 
the FMU LCD at the end of the transaction which matches pricing on the 3LD, and 2) unit 
pricing for all hoses configured in the FMU. 

These options must be enabled with a laptop connection in accordance with Product Bulletin 
111. The first option will show pricing to the fueling customer. When enabled, the unit price of 
the product being pumped from each hose may be displayed by depressing “A” on the FMU 
keypad. The first depression will show the unit price for the first hose. Subsequent depressions 
will show the unit price for each additional hose configured in the FMU. 

FMU transaction pricing may also be displayed on the FMU LCD, and compared to display 
pricing. After a transaction is run, the hose number, total sale price, and total sale quantity may 
be displayed on the FMU display. Existing fuel sites may already have some of these options 
turned on. It is a Weights & Measures requirement at self-service retail stations to display the 
sale at the end of the transaction. The 3LD permits the fueling customer to observe the sale 
while at the end of a long fueling hose. 

Perform the following, as desired: 

1. Connect a laptop to the FMU in accordance with Product Bulletin 111. 

2. To show pump pricing before a transaction is started: 

a. Type a 59 command and press Enter. A display similar to the following should appear: 

CURRENT SYSTEM OPTIONS (MENU 1) CONFIGURATION 

----------------------------------------------------------------------------------- 

SYSTEM INPUT TYPE : VMN - VEH. KEY 

CUSTOM SYSTEM OPTION : DISABLED 

ENTERED VEHICLE IDs ARE : ALPHANUMERIC 

SEMI MANUAL MODE : DISABLED 

REAL GATE TXN : DISABLED 

POWER FAIL CHECK : ENABLED 

ENTERED USER IDs ARE : ALPHANUMERIC 

FURNACE LOGGING : DISABLED 

USING OLD PROKEES : DISABLED 

SHOW PROKEE/SMARTCARD ID : DISABLED 

CONFIRM PROKEE/SMARTCARD ID : DISABLED 

DISPLAY PUMP PRICING : DISABLED 

EIU PROKEE/SMARTCARD WHICH KEYS : NO KEYS!!! 

TWO RELAYS PER PUMP : DISABLED 

AUTO ACTIVATE SINGLE PUMP : DISABLED 

MODEM CONNECT UPPER SPEED LIMIT : MAXIMUM 
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RESTORE DEFAULT VALUES 

USAGE - <LETTER>=CHANGE VALUE, <ESC>=EXIT 

b. Depress L. The display should reset to: 

L. DISPLAY PUMP PRICING :ENABLED 

c. Press Esc to exit. A display similar to the following should appear: 

CONFIGURATION HAS CHANGED!  

WOULD YOU LIKE TO SAVE IT ? (Y/N) 

d. Press Y to save the configuration change. The following prompt will appear: 
SAVING SYSTEM CONFIGURATION… 

CONFIGURATION RECORDED. 

e. To show pump pricing, press A on the FMU keypad. A display similar to the following 
should appear (the price shown is an example):CURRENT PRICES: (PUMP #1) A=NEXT, 
D=EXIT UNLEADED: $ 2.489 PER GL 

3. To show hose number, total quantity, and total cost at the end of a transaction: 
a. Type a 7D (or 7d) command, and press Enter. A display similar to the following should 

appear: 

Weights & Measures: Display Last TX Configuration 

---------------------------------------------------------------------- 

Command Interface: 7D, ARG1, #ARG2 ARG1 – Display Last TX: 0 Disable, 1 Enable 

ARG2 – Timeout in Seconds (Optional: Default=300, 0=Indefinitely) Current Configuration 

Display Last Transaction: Disabled 

NOTE The 3LD will display the last transaction until a new transaction is started, or until the 3LD is 
rebooted. 

b. ARG = argument. To enable the display of the last transaction, 7D, 1 must be entered 
(7D,0 would disable the display). Weights & Measures requires the transaction 
information to be displayed for 5 minutes, or until the next transaction is started. If 
the default 5 minutes (300 seconds) is desired, do not perform the second 
argument. Enter only 7D, 1. If a continuous display of the previous transaction is 
desired, enter 7D,1,0. (Whatever setting is made, if a new transaction is started, the 
display will clear and process the new transaction.) A display similar to the following 
should appear: 

CONFIGURATION HAS CHANGED! 

WOULD YOU LIKE TO SAVE IT ? (Y/N) 

c. Press Y to save the configuration changes. The configuration changes will be 
recorded and a display similar to the following should appear: 

SAVING SYSTEM CONFIGURATION…  

CONFIGURATION RECORDED. 

d. Type a 5b command, and press Enter. A display similar to the following should 
appear: 
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CURRENT RECEIPT PRINTER CONFIGURATION 

---------------------------------------------------------------------- 

A RECEIPT PRINTER : DISABLED 

B RCPTS PRINT ON PWR UP : DISABLED 

C RECEIPT ALWAYS : DISABLED 

D RECEIPT PRINTER TYPE : PEDESTAL 

E PEDESTAL RCPT PAPER CUT : FULL 

F RECEIPT PRINTER BAUDRATE : 2400 

G PRINT DOLLAR FOR FLEET RECEIPTS : DISABLED 

H PRINT DUPLICATE RECEIPTS : DISABLED 

I PRINT RECEIPT DATE/TIME STAMP : ENABLED 

J PRINT MASTER PRODUCT DESCRIPTION: DISABLED 

K PRINT RECEIPTS FOR AIM : DISABLED 

L PROMPT FOR AIM RECEIPTS : DISABLED 

M ALLOW $0.00 FOR PROKEE PRICING : ENABLED 

N RESTORE DEFAULT VALUES 

USAGE - <LETTER>=CHANGE VALUE, <ESC>=EXIT 

e. Press G. PRINT DOLLAR FOR FLEET RECEIPTS. The option should change from 
DISABLED to ENABLED. 

f. Press Esc to exit. A display similar to the following should appear: 

CONFIGURATION HAS CHANGED!  

WOULD YOU LIKE TO SAVE IT ? (Y/N) 

g. Press Y to save the configuration change. A display similar to the following should 
appear: 

SAVING SYSTEM CONFIGURATION…  

CONFIGURATION RECORDED. 

h. After a transaction is complete. A display similar to the following will appear on the 
FMU display (the cost and quantity are examples): 

HOSE: 1 – UNLEADED 

SALE: $177.43  50.84 GAL 
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Troubleshooting.  
Figure 16 is provided for troubleshooting purposes. The retrofit should not normally 
require the checks described in this wiring diagram. 

 

Figure 16 

 

Return Removed Parts 
An RMA and Federal Express return shipping ticket has been supplied with the retrofit kit 
parts. We request the Pulser Card (from the Internal Junction Box) and the External 
Junction Box be returned to Syntech. 

Update Firmware in 3LD.  
If it becomes necessary to update the firmware in the 3LD, Syntech will provide instructions and 
any equipment necessary to perform the upgrade. 
 

TIP If any questions arise, contact Syntech Systems, Inc.’s Customer Satisfaction Center (CSC) at 
1-800-888-9136, ext. 2, or email support@myfuelmaster.com. 
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Change Log 
Date Description 

3/11/2016 Original 

3/24/2016 Added requirement for FuelMaster software version 5.8.3.0 on page 6, Upgrade FMU 
Firmware and FuelMaster Software 

3/25/2016 Added CAUTION, page 9, “See Figure 13. Do not use JP5 or JP6 if resistors and diodes 
are soldered to the I/O Silver Board under the JP5 and JP6 receptacles.” 

4/8/16 

 

Changed Figures 15 and 16, Power Supply wire identification; solid black is ground, black 
w/stripe is positive. 

Removed 24VDC Power Supply from Figure 1, Standard 3LD Retrofit Parts. 

5/11/2016 Added 264796 breakout board and Velcro tape to list of retrofit parts. 

Page 2, Reset Display Configuration Before Retrofit, added “The display settings covered 
in this section apply to all three display lines”. 

Removed figure, page 9, illustrating workable I/O Silver Board applications. A new 
264736 I/O Silver Board will be sent with all retrofits. If another I/O Silver Board is 
installed and in use, the appropriate standoffs will be sent to install the 264736 I/O Silver 
Board over the previously installed board. 

Removed the wiring diagram, page 11, illustrating the wiring of the 3LD on other 
configurations of I/O Silver Boards. A new 264736 I/O Silver Board will be sent with all 
retrofits. If another I/O Silver Board is installed and in use, the appropriate standoffs will 
be sent to install the 264736 I/O Silver Board over the previously installed board. 

Added Troubleshooting header, page 15, and wiring diagram illustrating wiring of Internal 
Junction Box. 

Removed 12VDC power supply from list of parts to be returned to Syntech. A 24VDC 
power supply is not being shipped with retrofit kits. The 12VDC power supply already in 
use is more than adequate for shorter FMU to 3LD cable. 

5/12/2016 Page 8, Install FMU Components, removed reference to 24VDC power supply. 

Page 8, removed NOTE in middle of page, There are several …. 

Page 9, step 3.h.(4), added description for installation and use of breakout board: “Do not 
cover any screw holes in the I/O Silver Board. When a connection to the breakout board 
is necessary, the Velcro connection is separated to suspend the board from the jumper 
wires and permit access with a laptop connection cable.” 

6/14/2016 Page 8, added Figure 13, External Junction Box in FMU. 

Page 11, added Breakout Board to figure. 

Page 15, added Figure 16, Wiring from each Display to Internal Junction Box  

6/27/2016 Page 6, added NOTE at bottom of page, Important! When performing an FMU 
firmware upgrade, it is important to follow the guidance of Product Bulletin 218, 
Screenshots for FMU Firmware Updates/Recovery. Screenshots of the FMU 
configuration are taken before the upgrade,  then  the  FMU  is  initialized  to  clear  
memory  of  the  old  firmware.  The screenshots can then be used to reconfigure the 
FMU to the customer’s preferences with the new firmware. 

2/10/2021 Rebrand/reformat. 
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